
 

KPN Mobiel Internet Dashboard 

 





 

iii 

Table of Contents 
Welcome to KPN Mobiel Internet Dashboard .......................................................1 

Welcome to KPN Mobiel Internet Dashboard....................................................1 

Introduction .......................................................................................................1 

Introduction....................................................................................................1 

About This Help File ......................................................................................2 

What do the LED colors mean? .....................................................................2 

How To... .......................................................................................................5 

The KPN Dashboard Console ...........................................................................7 

The KPN Dashboard Console........................................................................8 

The Menu Bar ................................................................................................8 

Status Pane ...................................................................................................9 

System Tray Icon.........................................................................................10 

The Options Menu .......................................................................................10 

The Usage Tab ............................................................................................20 

The Help Menu ............................................................................................21 

SMS/Text Messaging...................................................................................23 

The Applications Tab ...................................................................................26 

Connection Properties .................................................................................27 

The Update Agent ...........................................................................................34 

Index ...................................................................................................................37 





 

Welcome to KPN Mobiel Internet Dashboard  

Welcome to KPN Mobiel Internet 
Dashboard  

KPN Mobiel Internet Dashboard  is a utility for Windows PCs that helps keep 
you connected. It simplifies both the initial installation and the daily use of 
network access devices such as PC cards, via a single, easy-to-use interface. 

  

This help file provides fast online access to all the KPN Mobiel Internet 
Dashboard  documentation. The documentation is, however, also available as a 
set of printable PDF manuals. 

  

Introduction 

Introduction 

KPN Mobiel Internet Dashboard is a tool that helps you get connected and 
manage your wireless connections on the go. It is preconfigured with the 
information you need to connect to your operator's cellular and wireless networks. 
KPN Dashboard assists you when roaming, warning you if you are connected to 
a different operator's network and risking a roaming surcharge. It lets you scan 
for WLAN or WiFi and cellular networks, monitor your network usage and set 
thresholds, if desired, so that you will be warned if you exceed data or time limits 
on your subscription. 

  

KPN Dashboard comes preconfigured with connection and application launch 
buttons, and supports the integration of various network-dependent applications, 
including: 

VPN clients, for encryption and privacy • 

• Mail clients 

• Internet browsers 

  

KPN Dashboard lets you configure connection and application preferences, so 
that you can customize the application to meet your particular needs. It contains 
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an SMS/text messaging application that allows you to send and receive 
messages and to import, manage and export SIM contacts. 

  

What do the LED colors mean? 

How To... 

About This Help File 

   

About This Help File 

This help file contains: 

• A general introduction to KPN Mobiel Internet Dashboard 

• A complete description of the application and its components: where to find 
various tools and functions, and how to use them 

• "How to" instructions for carrying out common tasks 

  

For installation instructions and a quick guide to getting started with KPN Mobiel 
Internet Dashboard, see Getting Started guide. 

What do the LED colors mean? 

What do the LED colors mean? 

  

Each device (Mobiel Internet Kaart or Mobiel Internet Modem) displays certain 
colors to communicate what state the device is currently in. 

  

Mobiel Internet Kaart 310 

Mobiel Internet Kaart 710 

Mobiel Internet Kaart 712 

Mobiel Internet Kaart 720 

Mobiel Internet Modem 802 

Mobiel Internet Modem 804 

Mobiel Internet Kaart 820 

Mobiel Internet Kaart 810 
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KPN USB-modem 

KPN USB-modem 2 

KPN Mobiel Internet Modem 904 

  

Mobiel Internet Kaart 310 

The LED on the ‘Mobiel Internet Kaart 310' has two different colours to show the 
different network types. Each colour of the LED equals a certain network type. 

Red LED: connection with a GPRS network 
Blue LED: connection with a UMTS network 

Mobiel Internet Kaart 710 

The LED on the ‘Mobiel Internet Kaart 710' has three different colours to show 
the different network types. Each colour of the LED equals a certain network type. 

Green LED: connection with a GPRS/ EDGE network 
Blue LED: connection with a UMTS network 
Cyan LED: connection with a HSDPA network 

Mobiel Internet Kaart 712 

The LED on the ‘Mobiel Internet Kaart 712' has three different colours to show 
the different network types. Each colour of the LED equals a certain network type. 

Green LED: connection with a GPRS/ EDGE network 
Cyan LED: connection with a HSDPA network 

Mobiel Internet Kaart 720 

The LED on the ‘Mobiel Internet Kaart 720' has two different colours to show the 
different network types. Each colour of the LED equals a certain network type. 

Red LED: connection with a GPRS or EDGE network 
Blue LED: connection with a HSDPA/UMTS network 

Mobiel Internet Modem 802 

The LED on the ‘Mobiel Internet Modem 802' has two different colours to show 
the different network types. Each colour of the LED equals a certain network type. 

Green LED: connection with a GPRS network  
Cyan LED: connection with a UMTS network 

Mobiel Internet Modem 804 
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The LED on the ‘Mobiel Internet Modem 804' has two different colours to show 
the different network types. Each colour of the LED equals a certain network type.  

Green LED: connection with a GPRS network  
Cyan LED: connection with a UMTS network. 

Mobiel Internet Kaart 820 

The LED on the ‘Mobiel Internet Kaart 820' has two different colours to show the 
different network types. Each colour of the LED equals a certain network type.  

Green LED: connection with a GPRS network  
Cyan LED: connection with a UMTS network 

Mobiel Internet Kaart 810 

The LED on the ‘Mobiel Internet Kaart 810' has three different colours to show 
the different network types. Each colour of the LED equals a certain network type.  

Red LED: connection with a GPRS network  
Blue LED: connection with a UMTS network 
Red LED: connection with a EDGE network 

KPN USB-modem 

In the USB-modem there is a multi-colour-LED (light), which shows the status of 
the modem, using different colours and flash-signalling:  

Red: Error Status, or Modem not ready yet, busy starting up. 
Green blinking: Attached to GPRS or EDGE network.  
Green burning: Active connection via GPRS or EDGE network.  
Purple blinking: Attached to UMTS or HSDPA network. 
Purple burning: Active connection via UMTS network.  
Blue burning: Active connection via HSDPA network.  
Light-Blue burning: Micro-SD memory-card found and ready to use. 

KPN USB-modem 2 

The LED on the ‘KPN USB-modem 2' has two different colours to show the 
different network types. Each colour of the LED equals a certain network type.  

 
Green LED: connection with a GPRS network  
Cyan LED: connection with a UMTS network. 

Mobiel Internet Modem 904 
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The LED on the ‘Mobiel Internet Modem 904' has two different colours to show 
the different network types. Each colour of the LED equals a certain network type. 

Red: Powering up, unregistered/scanning or PIN required 
Red/blue blinking: Firmware crash 

Green blinking: Registering to GPRS or EDGE network  
Green continuous: Active connection via GPRS or EDGE network.  
Blue blinking: Registering to UMTS or HSUPA network. 
Blue continuous: Active connection via UMTS or HSUPA network.  

How To... 

Start KPN Dashboard 

To start KPN Dashboard, either double-click on the KPN Mobiel Internet 
Dashboard desktop icon or select Programs > KPN Dashboard > KPN Mobiel 
Internet Dashboard from the Windows Start menu. 

Get Online 

To start an Internet connection, all you need to do is click on the Connect button 
in the Connection tab or click on one of the application launch buttons in the 
Applications tab of the KPN Dashboard console. 

   

Manage SIM Card PINs 

Select Options, Manage PINs to enter or change the USIM card PIN for a 
device or disable PIN usage. See Manage PIN Number for further details. 

Locate New WLAN Networks 

Select Options, Find WiFi Networks to display details of all the WLAN or WiFi 
networks (including public hotspots) available in your current location. See Find 
WiFi Networks for further details. 

   

Access a Home/Office WiFi Network 

To set up access to a WLAN or WiFi network in your home or office: 

1. Go to your home/office. 

2. Select Options, Find WiFi Network to display a list of all accessible WLAN 
networks. Note that the list may contain several networks if you have close 
neighbors with WLAN networks. 
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3. Select your network from the list, and click on Connect to open the WLAN 
Bearer Setting dialog. 

4. Unless your home network is a hidden network, the Network Name (SSID) 
field is already filled in with the correct name, so you do not need to modify it. 
If your home network is a hidden network, then enter the SSID here. 

5. Select the correct Security type and Encryption type options (you need to 
know what the correct settings are) 

6. Enter the correct Network security key (again, you have to know what this 
is). 

7. Click on Connect to save your changes, close the WLAN Bearer Settings 
dialog and connect or click Cancel to exit without saving any changes. 

  

Install A New Device 

Select Options, Advanced Settings, Device Installer to start the device 
installation wizard. 

Secure a Profile With Your VPN Client 

If one of the VPN clients supported by KPN Dashboard is installed on your PC, 
then you can create a secure KPN Dashboard profile by associating the VPN 
client with the profile. The VPN client will then be automatically started every time 
you establish a connection using the profile. 

Before you can secure an KPN Dashboard profile in this way, you must have: 

• Installed a supported VPN client 
• Created at least one working VPN profile 

  

To associate a VPN profile with an KPN Dashboard profile: 

1. Select the VPN button on the Applications tab to open the Task 
Properites dialog. 

2. Enter a Name for the VPN profile then select the profile you want to secure 
from the Connection profile pull-down list. 

3. Select the name of your VPN client in the Client field. 

4. If you want KPN Dashboard to be able to log in to the VPN for you, enter 
your VPN credentials in the user name and password fields. Otherwise, you 
will be prompted for these each time you establish a connection using this 
profile. 

6 



Welcome to KPN Mobiel Internet Dashboard  

5. Enter the name of the VPN profile you are going to use in the Profile name 
field. 

6. Only check the Use certificate and Use certificate password fields if your 
VPN client is set up to require them. 

7. Click on OK to save your changes and close the Task Properties dialog or 
click Cancel to exit without saving any changes. 

  

Check Your Network Usage 

You can check your network usage in the Usage tab of the Dashboard. See The 
Usage Tab for further details. 

Set Network Usage Thresholds 

Select Options, Advanced Settings..., Thresholds to set thresholds that you 
can use to limit your network usage. When you reach a threshold you have set, a 
warning message is displayed. See Thresholds for further details. 

Check Your Roaming Status 

You can check your roaming status at any time by looking at the roaming 
indicator ( ) in the KPN Dashboard console. See Status Pane for further 
details. 

Send and Receive Text Messages 

You can send and receive text messages and manage SIM card contacts from 
your PC using KPN Dashboard's built in SMS application, which you can start by 
clicking on the   button in the KPN Dashboard console or selecting the SMS 
launch button in the Applications tab. See SMS/Text Messaging for further 
details. 

Keep KPN Dashboard Up-to-Date 

By default, KPN Dashboard keeps itself up-to-date: it automatically checks for 
updates such as new versions of KPN Dashboard, device drivers and 
configuration files, and displays an Install Updates dialog whenever it needs to 
download and install data. Occasionally, however, you may want to explicitly 
check for updates (if you skipped a previous download due to a slow connection, 
for example). You can do this by selecting Help, Update Now.... See Update for 
further details. 

The KPN Dashboard Console 
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The KPN Dashboard Console 

The KPN Dashboard console contains an Options menu and a Help menu at the 
top, a tabbed status pane in the middle and a news banner at the bottom. 

These components are described below, along with KPN Dashboard's system 
tray icon. 

  

In the upper right-hand corner of the console are two buttons: 

: Minimizes the console to a system tray icon. 

: Terminates KPN Dashboard. 

  

The menus in the menu bar provide access to the full range of KPN Mobiel 
Internet Dashboard functionality and are described in the following sections: 

The Menu Bar 

Status Pane 

System Tray Icon 

The Menu Bar 

The menu bar contains the following menus: 

The Options Menu 
This menu contains the following options: 

Choose Profile 
Lets you change your active profile. 

• 

Find WiFi Network 
Detects any 

• 
WLAN or WiFi networks in your current location. 

• Find Cellular Networks... 
Lets you switch between automatic network selection (the default) and 
manual network operator selection. 

Manage PINs... 
Lets you enable and disable the PIN code security checks on SIM cards. 

• 

Advanced Settings... 
Provides access to a range of advanced functions. 

• 

The Help Menu 
This menu contains the following options: 
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Help 
Displays help about KPN Dashboard. 

• 

About 
Displays information about KPN Dashboard. 

• 

Update Now... 
Lets you check for and install the latest KPN Dashboard updates. 

• 

   

Status Pane 

Status Pane 

The middle of the KPN Dashboard console is occupied by a status pane used to 
display the following tabs: 

• Connection 
• Usage 
• Applications 

Connection tab 

Usage tab 

Applications tab 

Connection tab 

The Connection tab contains basic connection information such as signal 
strength and availability, along with the following: 

• A status message that either describes any action currently being performed 
by KPN Dashboard (Connecting, Ready to Connect) or indicates whether or 
not a connection is currently possible. 

• A row of network indicator that shows the current available cellular or Wi-Fi 
network and a row with signal strength scale and type of the currently 
attached network. In addition, the WWAN indicator includes a roaming 
indicator. When the text ROAMING is displayed it means the client is 
roaming on a non-partner network which may be more expensive than 
connecting in home network. 

VPN on/off indicator that indicates whether or not a • A VPN session is 
established via an integrated VPN client. This indicator is only used in KPN 
Dashboard versions that include an integrated VPN client. For further 
information about integrated VPN clients, see VPN Client 

• A new SMS/text message indicator that indiates when a new text message 
has been received. 
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Usage tab 

The Usage tab displays the following: 

• Connection History 
Select this option to display historical network usage information. The 
information is displayed in the KPN Dashboard console's status pane, 
replacing the usual status display. For details, see Connection History. 

• Current Session 
Select this option to display network usage information for the current 
session. The information is displayed in the KPN Dashboard console's status 
pane, replacing the usual status display. For details, see Current Session. 

Applications tab 

The Applications tab holds several application buttons which, when clicked, will 
launch the corresponding application such as SMS, VPN, Internet and Mail 
applications. 

System Tray Icon 

An KPN Dashboard icon is displayed in the system tray if the KPN Dashboard 
console has been hidden (minimized). To redisplay the console, double click on 
the icon. To terminate KPN Dashboard, right-click on the icon and select Exit 
from the menu. 

The Options Menu 

The Options Menu 

The Options menu contains the following options: 

• Choose Profile 
Displays a submenu containing the names of all your profiles. The active 
profile has a check mark next to it. To change active profile, select the profile 
you want to activate. 

• Find WiFi Networks... 
Displays the Find WiFi Networks dialog, which lists all WLAN or WiFi 
networks in the vicinity of your PC. 

• Find Cellular Networks... 
Displays the Network Mode Selection dialog, which you can use to switch 
between automatic network selection (the default) and manual network 
selection. If you switch to manual network selection, then you can select 
networks yourself when roaming, instead of letting KPN Dashboard do it for 
you. 
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• Manage PIN Number 
Displays the Manage PIN Number dialog, which you can use to enable and 
disable the PIN code security checks on SIM cards. 

• Advanced Settings... 
Displays the Advanced Settings dialog, which provides access to a 
collection of advanced configuration dialogs. Some of these dialogs (the 
more commonly used ones) are also accessible from other menu options. 

Choose Profile 

Find WiFi Networks 

Find Cellular Networks 

Manage PIN Number 

Advanced Settings 

   

Choose Profile 

You can select which profile you wish to use by accessing Choose Profile in the 
Options menu. Several profiles, such as Internet and Fast Internet, are made 
available by default however, you can add your own unique profiles by creating 
them in the Profiles dialog found in Advanced Settings... . 

Find WiFi Networks 

All WLAN or WiFi networks detected in the vicinity are listed in the Find WiFi 
Networks list. If you move the PC or believe that a new network has become 
available, you can force a new scan by clicking the Refresh button. 

The list contains the following information about each detected network: 

  

 
This icon, if displayed, indicates that the associated network/access point 
requires security (not visible on Vista). 

 
This icon, if displayed, indicates the signal strength (RSSI) of the associated 
network. 

  

SSID 
This is the name of the wireless network, usually broadcast by the wireless 
access point. 

To start using one of the detected networks: 
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• Select the network from the list. 
• Click on Connect... to configure the connection and start using it 

immediately. 

  

To Configure the Connection: 
You much first configure your network before you can use it. To configure: 

1. Select Options, Find WiFi Network to display a list of all accessible WLAN 
networks. Note that the list may contain several networks if you have close 
neighbors with WLAN networks. 

2. Select your network from the list, and click on Connect to open the WLAN 
Bearer Setting dialog. 

3. Unless your home network is a hidden network, the Network Name (SSID) 
field is already filled in with the correct name, so you do not need to modify it. 
If your home network is a hidden network, then enter the SSID here. 

4. Select the correct Security type and Encryption type options (you need to 
know what the correct settings are). 

5. Enter the correct Network security key (again, you have to know what this 
is). 

6. Click on Connect to save your changes, close the WLAN Bearer Settings 
dialog and connect or click Cancel to exit without saving any changes. 

  

Find Cellular Networks 

This dialog lets you switch between automatic and manual network selection. 
When roaming, you may sometimes wish to switch to a network other than the 
one selected by KPN Dashboard, for reasons of cost or quality. 

  

To switch to manual mode and select the roaming network yourself: 

1. Select Options, Find Cellular Network to open the Network Mode 
Selection dialog. 

2. Select Manual. 
3. Click on Choose operator... to display the Change Network Operator dialog. 
4. Select the required network and click Change Operator. 
5. Click OK. 

To switch back to automatic mode: 
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1. Select Options, Find Cellular Network to open the Network Mode 
Selection dialog. 

2. SelectDash Automatic. 
3. Click OK. 

Manage PIN Number 

Under normal circumstances, each time a cellular device with a SIM card is 
inserted, you will be prompted to enter the PIN code. Until you have entered the 
correct PIN code, you will not be able to use the device. This option lets you 
disable and re-enable the PIN code on a PC card and, in the case of some 
devices, change the PIN code. 

  

To modify the PIN code setting of a PC card: 

1. Select Options, Manage PIN Number to open the PIN Management dialog. 
2. To disable the PIN code, check No PIN, to enable it, check Use PIN. 
3. If the fields Current PIN, New PIN and Confirm PIN are displayed then you 

can change the PIN code by entering the old PIN code in the Current PIN 
field and the new PIN code in both the New PIN and Confirm PIN fields. 

Advanced Settings 

Advanced Settings 

Some of the Advanced Settings dialogs allow you to make changes that can 
affect the operation of the client, so you should be careful when using them, and 
only make changes in consultation with your system administrator or product 
support specialist. For the same reason, you may need to enter a password in 
order to access the Advanced Settings dialog. If this is the case, ask your 
system administrator or product support for the password. 

  

The Advanced Settings dialog contains the following options: 

• Connections 
Displays the Connections dialog, which you can use to add, modify and 
delete connections. This dialog can also be accessed from the KPN 
Dashboard console's Settings menu. 

• Default Devices 
Displays the Set Default Devices dialog, which you can use to change KPN 
Dashboard's default devices.This dialog can also be accessed from the 
KPN Dashboard console's Settings menu. 
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• Device Installer 
Displays the Device Installer wizard, which you can use to install new 
devices such as PC cards, USB devices, serial cable devices, Bluetooth 
devices or infra-red devices. This wizard can also be started from the KPN 
Dashboard console's Settings menu. 

• Diagnostics 
Displays the Diagnostics dialog, which provides access to a range of 
diagnostic information. 

• Export Setup 
Displays the Export Setup dialog, which lets you save your current KPN 
Dashboard configuration to file. This dialog can also be started from the KPN 
Dashboard console's File menu. 

• Import Setup 
Displays the Import Setup dialog, which lets you load an KPN Dashboard 
configuration from file. This dialog can also be started from the KPN 
Dashboard console's File menu. 

• Preferences 
Displays the Preferences dialog, which allows you to set various general 
application preferences. 

• Profiles 
Displays the Profiles dialog, which you can use to add, modify and delete 
profiles and set the active profile.This dialog can also be accessed from the 
KPN Dashboard console's Settings menu. 

• Restore Configuration 
Displays the Restore Configuration dialog, which lets you save and 
restore the KPN Dashboard configuration to an earlier state. 

• Set Password 
Displays the Set Password dialog, which lets you set password protection 
on the Advanced Settings dialog. 

• Thresholds 
Displays the Thresholds dialog, which allows you to place limits on your 
network usage. 

Diagnostics 

Preferences 

Restore Configuration 

Set Password 

Thresholds 

   

Diagnostics 

The Diagnostics dialog provides a range of diagnostic information, including a 
log file, general information about the PC on which the software is installed, plus 
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hardware and software information relevant to the operation of KPN Dashboard . 
It also provides shortcuts to various Windows Control Panel tools that can be 
useful when troubleshooting. 

  

The dialog contains three tab cards: 

• Diagnostics 
This tab contains general information about the system hardware and 
software. Of particular interest is the Defect Analysis option, which displays 
information about any PC card defects detected by KPN Dashboard. Under 
normal circumstances, selecting this option does not display any information 
in the right-hand pane; information is only displayed there if an error has 
been detected. Should you have a problem and find information displayed by 
the Defect Analysis option, click on Save to save the information to disk 
and contact support. 

• Log 
This tab displays a log file describing recent connection manager activity. 

• Shortcuts 
This tab contains shortcuts to various useful Windows Control Panel tools. 
Note that any changes you make using these tools will have a system wide 
effect, and should therefore only be made on the advice of your system 
administrator or support personnel. Local administrative rights on the PC 
may be required to make changes. 

The Save button saves the diagnostics information to disk. 

Preferences 

Preferences 

Selecting this option displays the Preferences dialog, which allows you to set a 
variety of general application preferences. It contains a number of tab cards, 
each containing a group of related parameters. 

General Tab 

Connect tab 

WLAN tab 

Window tab 

WWAN tab 

General Tab 

This tab contains the following parameters: 
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Auto start 
Check this option if you want KPN Dashboard to be automatically started after 
system boot. 

  

Automatically select devices at start-up 
Check this option if you want KPN Dashboard to automatically select devices on 
start-up. 

  

View selection dialog if autoselection fails 
Check this option if you want KPN Dashboard to display a device selection dialog 
if start-up device selection fails. 

  

Automatically select default device at Plug and Play 
Check this option if you want KPN Dashboard to automatically select the default 
device when a new device is inserted and recognized by the Windows Plug 'n' 
Play system. 

  

View selection dialog if autoselection fails 
Check this option if you want KPN Dashboard to display a device selection dialog 
if Plug and Play device selection fails. 

  

Always autoselect inserted device 
Check this option if you want KPN Dashboard to always automatically select new 
devices when they are inserted. 

  

Auto scan for networks in active profile 
Check this option if you want KPN Dashboard to periodically scan for the 
networks in the active profile. 

  

Scan interval in minutes 
Specify how often you want KPN Dashboard to scan for networks. 

   

Connect tab 

This tab contains the following parameters: 
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Automatically connect on application startup 
Check this option if you want KPN Dashboard to automatically connect using the 
active profile as soon as it is started. 

  

User confirmed disconnect 
Check this option if you want KPN Dashboard to request confirmation before 
disconnecting from a network. 

  

Connect retry  
Select what you want KPN Dashboard to do when a connection attempt fails: 

• None  
Do nothing. 

• User Confirmed 
Display a prompt asking if you want to try again. 

• Automatic 
Try again automatically, without displaying a prompt. 

  

Automatically reconnect on lost connection 
Check this option If you want KPN Dashboard to automatically try reconnecting 
when connections are lost. 

  

Connect interval in seconds 
Specify how long you want KPN Dashboard to wait between reconnection 
attempts. 

  

Max connect tries 
Specify the number of times you want KPN Dashboard to try to reconnect. 

  

Unlimited connect tries 
Check this option if you want KPN Dashboard to try to reconnect indefinitely. 

   

WLAN tab 

This tab contains the following parameters: 
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Auto scan for wireless networks 
Check this option if you want KPN Dashboard to periodically search for new 
WLAN networks. 

  

Intervals between scans in minutes 
Specify how frequently you want to search for new WLAN networks. 

  

Popup dialog when networks are found 
Check this option if you want KPN Dashboard to display a dialog whenever a 
new network is discovered. 

   

Window tab 

This tab contains the following parameters: 

  

Always on top 
Check this option if you want KPN Dashboard window to be displayed on top of 
all other windows. 

  

Window startup size 
Select how you want KPN Dashboard window to be on start up: expanded or 
minimized. 

WWAN tab 

 

This tab contains the following parameters: 

  

Use roaming threshold 
Check this option if you want KPN Dashboard to warn you of your data usage 
while roaming. You can set the warnings to occur after 1 megabyte transferred or 
higher. 

Restore Configuration 

This dialog lets you: 

• Restore KPN Dashboard's original configuration or to restore other earlier 
configurations that you have saved by setting restore points. 
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• Set restore points in order to save a working configuration that you can 
easily return to. 

  

This function is very useful if you are experimenting with a variety of set-ups. 
Before you start changing settings you can create a restore point to which you 
can easily return if your changes don't work as expected. 

  

To create a restore point: 

1. Enter a name in the Restore point name field. 
2. Click on Create. 

The new restore point is then added to the Restore points list. 

To restore an earlier configuration: 

1. Select the required restore point from the Restore points list. 
2. Click on Restore. 
3. Confirm your selection by clicking Yes. 

To restore the original delivered configuration: 

1. Click on Restore default. 
2. Confirm your selection by clicking Yes. 

To restore the original delivered configuration: 

1. Click on Restore default. 
2. Confirm your selection by clicking Yes. 

To delete a restore point: 

1. Select the required restore point from the Restore points list. 
2. Click on Delete. 
3. Confirm your selection by clicking Yes. 

Set Password 

This dialog is normally used by a system administrator to prevent ordinary users 
from accessing advanced options in a configuration created for widespread 
distribution. 

To set password protection: 

1. Select Enable password. 
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2. Enter your password twice, in the Password and Confirm password fields. 
3. Click on OK. 

  

To remove password protection: 

1. Select Disable password. 
2. Click on OK. 

Thresholds 

You can use this dialog to limit the amount of time you are connected in a given 
period and/or the amount of data you transmit in a given period. You can set 
different limits for different bearers. When a specified threshold is reached, a 
message is displayed offering you the option of terminating your connection. 
Connections are not, however, forcibly terminated. 

  

The specified thresholds apply to all traffic over a particular bearer, irrespective 
of the particular connections used. You can, however, also specify thresholds for 
particular connections. 

The Usage Tab 

The Usage Tab 

This menu contains the following options: 

• Connection History 
Select this option to display historical network usage information. The 
information is displayed in the KPN Dashboard console's status pane, 
replacing the usual status display. For details, see Connection History. 

• Current Session 
Select this option to display network usage information for the current 
session. The information is displayed in the KPN Dashboard console's status 
pane, replacing the usual status display. For details, see Current Session. 

Connection History 

Current Session 

Connection History 

The Connection History pane contains statistics regarding all traffic sent and 
received via KPN Dashboard during a selected period. It contains a bar graph 
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showing the total traffic (upload and download) for each day during the selected 
period, for a selected bearer or all bearers. 

You can select the time period and bearer you are interested in using buttons 
above the graph. The time period options are: 

• Today 
• This week 
• Last 7 days 
• Current month 
• Last 30 days 
• Previous month 

  

The Bearer options are: 

• All bearers 
• WLAN 
• 3G 

  

Click on the Reset button to reset the history function (that is, clear all currently 
stored historical data). Click on the Back button to redisplay the normal status 
pane. 

Current Session 

The Current Session pane contains a graph of the download speeds achieved 
during the current session, the duration of the current session, plus the following 
statistics for both upload and download traffic: 

• Speed 
• Volume 
• Average speed 

  

Click on the Back button to redisplay the normal status pane. 

The Help Menu 

The Help Menu 

The Help menu contains the following options: 
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• Help 
Displays Help about KPN Dashboard. 

• About 
Displays copyright and version information about KPN Dashboard. 

• Update Now... 
Displays the Update dialog, which lets you check for and install the latest 
KPN Dashboard updates. See Update for details. 

  

Update 

Update 

This dialog lets you check for KPN Dashboard updates. You will not normally 
need to use it, since KPN Dashboard incorporates an update agent that runs in 
the background and periodically checks for updates (see The Update Agent). 
You may, however occasionally want to use it to get an update that you 
previously skipped downloading due to a slow connection. You can also use 
options in this dialog to control the behavior of the update agent. 

  

The dialog contains the following options: 

  

Turn on Automatic Update feature 
This option switches the update agent on and off, and is selected by default. If 
you deselect it, then the agent is switched off and will not automatically check for 
updates. If you do this, then you will not receive any updates unless you explicitly 
check for them by selecting Help -> Update Now. 

  

Download updates silently in background 
This option determines what happens when updates are found. By default, the 
Install Updates dialog is displayed, listing the updates that have been found 
and information about them. You can then choose to download and install all, 
some or none of them. If, however, you check this option, then all available 
updates downloaded in the background, and you are only informed when 
downloading is complete. 

  

If you choose the option Download updates silently in background, then any 
updates found will be selected and downloaded silently in the background and 
KPN Dashboard will inform you when the download is finished. 
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You can select the files you want to download and install by clicking in the check 
boxes. Some files, however, may be marked as mandatory. It is not possible to 
de-select these files. 

  

The Snooze button allows you to delay the update check. The update dialog will 
then reappear after the time interval specified in the Click Snooze to re-check 
in field. 

  

Click OK to download and install the updates. 

SMS/Text Messaging 

SMS/Text Messaging 

KPN Dashboard includes a simple SMS (text messaging) application which you 
can start by clicking on the   button on the Connections tab or by clicking the 
SMS launch button from the Applications tab. 

  

The application allows you to:  

• Send, receive, reply to, forward and save messages 
• Import/export contact details from/to the SIM card and also import contact 

details from Microsoft Outlook or a CSV file. 
• Edit contact details 

  

From the Contacts menu you can import or export contacts from/to the SIM card 
as well as import contacts from the MS Outlook Address book. 

  

The Actions menu allows you to perform actions on the messages stored in the 
application's folders (see Messaging Functions), create personal folders and 
move messages between folders. 

  

The Extra menu allows you to modify the application's parameter settings. 
Normally, the SMS application reads all the parameters it needs from the device 
SIM card. You should therefore not need to change these settings. 
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If you send a message when you are not connected to a network, then it is stored 
in the SMS application's Drafts folder. You can then send the message from the 
Drafts folder when a connection becomes available. 

  

Messaging Functions 

Messaging Functions 

To send a message: 

1. Click the New button. 
2. Enter the recipient's mobile phone number in the Phone number field. If 

there are several recipients, separate the numbers with a semicolon (;). You 
can also select recipients from your Contacts list by clicking To… 

3. Compose your message in the Message field and click Send. 

  

To reply to a received message: 

1. Open the message to which you want to reply and click Reply. 
2. Compose your message in the Message field and click Send. 

  

To forward a text message: 

1. Open the message you want to forward and click Forward. 
2. Enter the recipient's mobile phone number in the Phone number field. If 

there are several recipients, separate the numbers with a semicolon (;). You 
can also select recipients from your Contacts list by clicking To… 

3. Compose your message in the Message field and click Send. 

  

To delete a text message: 
Select the message you want to delete and click Delete. 

  

To save, edit or delete a text message draft: 

• Save a composed text message draft in the Drafts folder by clicking Save. 
• Edit a saved text message draft by opening it from the Drafts folder. 
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• Delete a saved text message draft by selecting it and then selecting Actions, 
Delete. 

  

To add a contact: 

1. Select Contacts, New. 
2. Fill in the Name and Phone number fields. 
3. Click OK. 

  

To edit a contact: 

1. Open the Contacts folder and select the contact you want to edit by double-
clicking on it. 

2. Make your changes in the Name and Phone number fields. 
3. Click OK. 

  

To delete a contact: 
Open the Contacts folder and select a contact you want to remove by clicking 
Delete in the Actions menu. 

1. Open the Contacts folder and select the contact you want to delete 
2. Select Actions, Delete. 

  

Importing and exporting contacts: 
When you import contacts from any source, the contacts are merged with any 
existing contacts in the SMS application: if any duplicate contacts are found, you 
are asked which one you want to keep. This does not, however, happen when 
you export contacts; in this case existing contacts are simply overwritten. To 
merge existing SIM card contacts with contacts from other sources, therefore, 
you should do as follows: 

1. Import contacts from the SIM card. 
2. Import contacts from other sources and deal with any conflicts that arise. 
3. Export the merged contact list back to the SIM card. 
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Changing SMS centre 
You can change SMS center from the default one provided by your operator. 
This means that text messages will be routed via a different center. You change 
SMS center by selecting SMS Centers on the Extra menu in the Dashboard's 
SMS center. 

The Applications Tab 

The Applications Tab 

KPN Dashboard is set up to launch third-party applications with the click of a 
button. There are several different types of applications that can be launched in 
this way, each of which is defined using a different set of parameters. This 
section describes the different application types. For descriptions of the various 
ways in which KPN Dashboard can be set up to launch applications, see 
Connection Properties. 

  

SMS 

Internet Browser 

Email Client 

VPN Client 

SMS 

KPN Dashboard includes a simple SMS (text messaging) application which you 
can start by clicking on the  button on the Connections tab or by clicking the 
SMS launch button from the Applications tab. see  

Internet Browser 

This icon is used start your default Internet browser. 

Email Client 

This type can be used to start your default email client. 

VPN Client 

This application type can be used to start a supported VPN client. KPN 
Dashboard handles not only start-up of the VPN client, but also establishment 
and termination of a VPN tunnel. 

You can specify the following parameters: 
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Client 
The VPN client to use. 

  

Username 
The user name needed to log into the VPN. 

  

Password 
The password needed to log into the VPN. 

  

Profile name 
The name of the VPN client profile to use. 

  

Use certificate 
Check this option if your VPN is set up to use a certificate for authentication 
purposes. 

  

Use Certificate Password 
Check this option if the VPN authentication certificate requires a password. 

  

For information about VPN client configuration, please refer to your VPN client 
manual or network administrator. 

Please note the following: 

• KPN Dashboard directly supports the following VPN clients: Microsoft, Cisco 
Systems, CheckPoint, SonicWALL and Nortel. 

• KPN Dashboard does not monitor the status of an established VPN tunnel. 
You must use the VPN client's user interface for this purpose. KPN 
Dashboard will not give any warning if the VPN tunnel is terminated for any 
reason. 

   

Connection Properties 

Connection Properties 
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When you select a connection for editing or add a new connection, the 
Connection Properties dialog is displayed. (If you are adding a new connection, 
then the dialog is called Add Connection, but the content is the same).  

  

The dialog contains two tabs, General and Applications.  

  

The General tab contains controls for setting usage thresholds. For information 
about usage thresholds, and advice on how to set these fields see Thresholds.  

  

The Applications tab lets you associate applications with the connection, so 
they are automatically launched when the connection is established. For further 
information about these settings, see The Applications Tab. 

  

The General tab also contains a Properties... button. Clicking on this button 
displays a new bearer-specific settings dialog. This dialog contains a variable 
number of tabs depending on the connection type (bearer). These tabs are 
described in the following topics. 

3G Tab 

Association tab 

General Tab 

Internet Protocol Tab 

PPP Tab 

Proxy Tab 

Security Tab 

3G Tab 

  

Access point name 
Enter the name of the access point to be used for 3G connections. 

  

PDP type 
Select either IP or PPP. Most terminals and networks only support IP. 

Association tab 

  

28 



Welcome to KPN Mobiel Internet Dashboard  

Network name (SSID) 
Enter the SSID of the wireless network. 

  

Network broadcasts SSID 
Check this option if the wireless network broadcasts its SSID (is not a hidden 
network). 

  

Security type 
Select the security scheme used on this wireless network.  

  

For any selection other than None (Open), you will need to fill in some or all of 
the remaining fields in the dialog. Any fields that are irrelevant for the option you 
select are disabled. If you have set up the wireless network yourself (i.e., at 
home), then the values you enter must match the corresponding entries in the 
wireless access point setup.  

For other networks, you must obtain the correct settings from the operator or 
network administrator. 

  

Encryption type 
Select the data encryption algorithm used by this wireless network. The options 
available in the list will vary according to the option you selected in the Security 
type field. 

  

Network security key 
Enter the encryption key required by the data encryption algorithm. 

  

Hide key 
Check this option if you do not want the security key you enter to be legibly 
displayed in the Network security key field. 

Key index 
Enter the key index required for network authentication. 

  

The key is provided for me automatically 
Check this option if the network automatically supplies security keys. 

   

General Tab 
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Show modem lights 
Check this option if you want a connection icon to be displayed in the windows 
system tray, indicating that a connection has been established and providing 
access to connection status information. 

  

Disconnect when idle 
Check this option if you want the connection to be automatically disconnected 
when it is idle. You must then specify how long the connection is allowed to be 
idle before it is disconnected in the Time limit in minutes field. 

Internet Protocol Tab 

This tab contains the following controls: 

  

Obtain an IP address automatically 
Select this option if your network assigns IP addresses automatically from a 
DHCP or Radius server. This is usually the case, so if in doubt, choose this 
option. 

  

Use the following IP address 
Select this option if your network manager has supplied you with a fixed IP 
address. Enter the IP address, Subnet mask and Default gateway address 
supplied by your network manager. 

  

IP and DNSMost networks support assigning  address details automatically via 
either a DHCP or Radius server. In that case, the default settings for automatic 
assignment are recommended. In some cases, however it may be required to 
assign IP and DNS address information manually. 

  

Obtain DNS server address automatically 
Select this option if your network supplies a DNS server address automatically. 
This is usually the case, so if in doubt, choose this option. 

  

Use the following DNS server address 
Select this option if your network manager has supplied you with fixed DNS 
server addresses. Enter the supplied addresses in the Preferred DNS serverand 
Alternate DNS server fields. 
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DNS Suffix 
Enter a DNS suffix that will be appended to any unqualified host names used on 
this connection. If, for example, the user tries to access a host called "xyz" and a 
DNS suffix of "mycompany.com" has been specified, the host actually searched 
for will be "xyz.company.com". The suffix is only appended to unqualified host 
names (that is host names that do not already include a DNS suffix). 

  

Preferred WINS server 
Enter the IP address of the preferred WINS server that is to be used for resolving 
NetBIOS names. 

  

Alternative WINS server 
Enter the IP address of an alternate WINS server that is to be used for resolving 
NetBIOS names, if the preferred WINS server is not available. 

   

PPP Tab 

This tab allows you to set PPP parameters and Microsoft networking options, 
should it be necessary to use non-default settings (to connect to a corporate 
network, for example). Please consult your network administrator or Windows 
Support Center if you need to configure these settings. 

Proxy Tab 

Proxy Tab 

This tab card contains two groups of parameters, Automatic configuration and 
Proxy server. 

  

Override local proxy settings 
Check this option if you want to override local proxy settings and specify a proxy 
server here. The Proxy server parameter group is then enabled. 

  

Automatically detect settings 
Check this option if you want proxy server settings to be automatically detected 
and configured on a per-connection basis. 

  

Use automatic configuration script 
Check this option if you want to use a PAC configuration script. You must then 
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enter the URL of a server containing the script into the Address field. This option 
is useful in some corporate remote access scenarios. 

  
Use a proxy server 
Check this option if you want to use a proxy server for outgoing HTTP 
connections. You must then enter the IP address of the proxy server and the port 
number to use in the Address and Port fields. 

  

Bypass proxy server for local addresses 
Check this option if you do not want to use the proxy server for internal HTTP 
traffic. 

  

Advanced... 
Click on this button to display the Proxy Settings dialog, which you can use to 
specify your use of proxy servers in more detail. 

  

Proxy Settings 

   

Proxy Settings 

You can use this dialog to specify different proxy servers for different types of 
traffic, and to prevent requests to certain domains from being routed via a proxy. 
It contains the following controls: 

  

HTTP 
These fields contain a copy of the address and port number entered into the 
Address and Port fields in the Proxy tab on the main bearer settings dialog. If 
you change the settings here, they will also be changed on the Proxy tab. By 
default this proxy address and port number will be used for all requests. If, 
however, you uncheck Use same proxy for all protocols, then they will only be 
used for ordinary HTTP requests. 

  

Secure 
If you uncheck Use same proxy for all protocols, then you will need to enter a 
proxy address and port number in these fields for use with secure HTTPS 
requests. 
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Use same proxy for all protocols 
Uncheck this option if you want to use different proxy servers for HTTP and 
HTTPS requests. 

  

Do not use proxy for addresses beginning with 
Enter the names of any domains for which you do not requests to be routed via a 
proxy. The domain names must be separated by semicolons (for example 
www.mycompany.com;www.yourcompany.co.uk). 

   

Security Tab 

Security Tab 

The contents of the Security tab vary according to connection type. 

LAN/WLAN Security 

GPRS/3G Security 

LAN/WLAN Security 

The Security tab for LAN and WLAN connections contains the following controls: 

  

Login Module 
KPN Dashboard includes login modules that can automatically log in to certain 
kinds of WLAN hotspots for you. The different login modules support different 
hotspot login mechanisms. If this connection is to be used to connect to a hotspot 
with one of the supported login mechanisms, choose the appropriate module and 
enter your login credentials into the Username, Password and Confirm 
Password fields. If the connection is not to be used for connection to a hotspot, 
or if the hotspot's login mechanism is not supported, choose None. Your 
credentials are stored in encrypted form. 

  

Enable firewall 
This option is only available on the Security tab for WLAN connections, and only 
on Windows XP. Check it to enable the Windows XP firewall on the connection. 

   

GPRS/3G Security 

The Security tab for GPRS and 3G connections contains the following controls: 
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Enable firewall 
This option is only available on Windows XP. Check it to enable the Windows XP 
firewall on the connection. 

  

Authentication 
Select the required authentication protocol (if any) from one of the displayed 
options: 

• PAP 
• CHAP 
• MS-CHAP 

Your network manager or provider should tell you which of these options to 
select. If you select an authentication protocol, then you will need to: 

• Either enter your login credentials into the Username, Password and 
Confirm Password fields. Your credentials are stored in encrypted form. 

• Or check the Prompt for username and password option. You will then be 
required to enter your Username and password at connection time. 

   

The Update Agent 

KPN Dashboard incorporates an update agent that runs in the background and 
periodically contacts a server over the Internet to check for updates such as new 
versions of KPN Dashboard, device drivers or configuration files. If any updates 
are available, then the Install Updates dialog is displayed. 

  

This dialog lists the available updates and allows you to choose what to do with 
them. It offers the following options: 

  

Select All 
Selects all the listed updates (checks the boxes on the left of the entries). You 
can also select individual entries yourself by checking these boxes). 

  

Show All/Hide Skipped 
This button determines what updates are included in the list. By default, any 
updates you have chosen to Skip are not displayed in the list. If you click on 
Show All, however, then skipped updates are displayed in italic. You can hide 
them again by clicking on Hide Skipped. 
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Skip 
If you do not want to download and install all the updates, you can skip some by 
checking the boxes to the left of them and clicking this button. They will then 
either disappear from the list or be displayed in italic. Note that some updates are 
mandatory; that is, you are required to install them. They are checked, and 
disabled so that you cannot uncheck them. They are, however, not affected when 
you click Skip. 

  

OK 
Click on this button to download and install the selected updates. All the updates 
that are checked will be installed. 

The update files can sometimes be large (several megabytes or more), so if you 
are currently using a slow network connection, it is a good idea to check the size 
before you start a download. If an update is large, then you may want to wait until 
you are connected via LAN or Wireless LAN before downloading it. 

  

Cancel 
Click on this button to cancel the update. No action will then be taken. Nothing 
will be downloaded or installed. 

  

Snooze 
Click on this button to put off the update until later. You can choose how long you 
want to put the update off for from the pull-down field on the right. When the 
selected time has elapsed, this dialog will be redisplayed. 

  

By default, this dialog is displayed whenever updates become available, but you 
can modify this behavior using the Update dialog. 

  

What the Skip Button Does 
You can avoid installing a particular update in two ways: 

1. You can not select it before you press OK. 
2. You can use the Skip function to hide it. 

  

The difference between them is that method 1 skips installing it just this time, 
whereas method 2 marks the update as "not to be installed". So the next time the 
Install Updates dialog is displayed, an update that was skipped using method 1 
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will appear in the list again, ready for you to install it, but an update that was 
skipped using method 2 will not. 

  

You can at any time change your mind and install an update that you have 
previously hidden using the Skip function. To do this, click on Show All to show 
the skipped updates, and then check the box on the left of the update you want 
to install. This both removes the "skip" marker from the update and selects it for 
installation. 
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